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proofSIGN
...verifies your proofs

manual
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Installation

Mac
Copy the proofSIGN application into your Applications Folder

Windows
If the CD doesn’t auto launch, then double click on proofSIGN_Setup.exe to start the installation procedure. If you get 
a warning about proofSIGN not having a Microsoft digital signature, then click Continue and complete the installation 
procedure.

Eye-One Driver for Windows
If you have never used an Eye One on the computer you have installed proofSIGN, then when you first plug in the 
Eye-One you will be asked for the driver.

         

Make sure the proofSIGN CD is in the drive and follow the onscreen instructions.

What’s on the CD
As well as the application, or installer, there are several files and folders included on the CD.

proofSIGN Chart.tif	 - This is the verification chart. Add this file at the bottom of every print
RIP Files		  - Instructions and files needed for specific RIPs
license.rtf		  - End User License Agreement.
driver			   - Windows Eye-One Driver (Windows CD only)
proofSIGN_Setup.exe	 - Windows installer (Windows CD Only)
proofSIGN		  - Mac application (Mac CD Only)
proofSIGN Manual.pdf	 - This manual
ISO ICC Profiles	 - ICC Profiles of the ISO Standards proofSIGN verifies to.

Contents of the Windows CD

Contents of the Mac CD
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Activating proofSIGN
Launching proofSIGN
Connect the Eye One to the computer before launching proofSIGN

The first time you launch proofSIGN are asked to fill in some default settings.

The proofSIGN activation code is generated online by visiting https://www.bodoni.co.uk/proofsign.php. If the computer 
you are installing proofSIGN on is connected to the internet, then you can click on the URL link just below the area 
which asks for the activation code. The code that needs to be typed in here IS NOT the code that is within the CD 
Case.

Fill in the name of the proofer you are using. This could just be the name of the printer, or printer & paper combination.

Fill in your company name. This is printed on every label and PDF report. The company name can be changed later in 
the preferences. 

Filling in the activation information
Use a browser to open https://www.bodoni.co.uk/proofsign.php

https://www.bodoni.co.uk/proofsign.php

Fill in the details as requested. If the Eye-One serial number wasn’t filled in automatically, you can find the serial 
number on the calibration plate of the Eye-One.

When you receive the activation email, type in your activation code as given into proofSIGN. This activation code is 
per Eye-One. Each additional Eye-One you wish to use with proofSIGN requires another proofSIGN license.    
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Using proofSIGN

Printing the proofSIGN Chart
Included on the proofSIGN CD is ‘proofSIGN Chart.tif’. This is the chart layout file that needs to be included on each 
proof so that you can use proofSIGN to verify the proof. Make sure the chart has the same colour management ap-
plied as the main job.

proofSIGN Chart

Using proofSIGN with RIPs
Included on the CD are instructions and the specialised charts for several RIPs. These instructions include how to load 
the chart into the RIP as an inbuilt chart, so that the RIP can automatically add the proofSIGN chart at the bottom of 
every proof.

Main window

Calibrating the Eye-One
Click ‘calibrate’ from the main window

Calibrate window



Page 5

If the calibration wasn’t successful, then make sure the Eye-One is sitting neatly on the calibration plate and try again.

Calibration success

If the calibration is successful, then click on the ‘Measure’ button. 

Starting a new measurement
You can start measurement either by clicking on ‘Measure’ from the main window, or after calibrating the Eye-One.

Measure window
Measure the first line of the control strip as instructed. The most consistent results are when the button on the Eye-
One is held over the white area at either end of the strip for a second before moving the Eye-One, and held for a 
second at the end of the strip. Also smoothness is the key, not slowness. The proofSIGN chart should take about 6   
seconds to complete each strip. Repeat for both strips in the chart.
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Evaluating Measurements

Main window after measurements

After each line of the control strip has been measured you are returned to the main window, where you can now see 
the results.

Hopefully your proof has passed and you can look at the ∆E values for each of the patches in the info window.

What does ∆E mean?
∆E is a measure of how close two colours are. The lower the ∆E, the closer the colours should be visually to each 
other. 

What does ∆H mean?
∆H is a measure of how close the hue of a colour is to the target. Visually, the hue of a colour - especially neutrals have 
a large impact on how close we visually see colour differences.

ISO 12647-7
ISO 12647-7 is a proofing verification standard which proofSIGN fully supports.
For a proof to pass ISO 12647-7, it must pass the following conditions:
Maximum ∆E less than 6
Average ∆E less than 3
Maximum Promary ∆E less than 5
Paper Colour ∆E less than 3
Average grey balance ∆H less than 1.5
Maximum ∆H of the CMYK promaries less than 2.5

 

∆E 76(ab)
This is the standard method for calculating ∆E. This method is required for ISO 12647-7 compliance.
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Using the info window
The info window shows the measured and target Lab values, the name and CMYK makeup for each patch in the 
chart. The info window can be shown or hidden by pressing ‘Command I’ on a Mac, or ‘control I’ on a PC, or by 
clicking ‘Show Info’ from the ‘Window’ menu.

Info window

There is also a colour patch showing the measured colour and the target colour split diagonally across so you can 
see visually the difference between the target and measured colour. If you can’t see a difference, then that’s good 
-the ∆E isn’t big enough for you to see a difference on screen.
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Viewing the results
When the measurements are complete, then you can print a label, or save a comprehensive PDF report.
Click ‘View Report’ from the main window.

 
View report window

You can change the Job name/ID if you are printing proofs from more that one source on a single print so that you can  
nest multiple jobs and only print out a single verification chart per page.

Saving the PDF Report

Click ‘Save PDF Report’ to save the PDF report that you can keep for your records.

proofSIGN Certification
Job name : 
Printed by :
Proofer :

Proof Target :

ISO Test Job
Bodoni Systems Ltd
Epson Stylus Pro 7800

proofSIGN ISO - ISO Coated v2 (ECI)
Date : Friday, 20 July 2007

dE
Measured  Tolerance

dH
Measured  Tolerance

Cyan 5.002.62 Pass 2.500.32 Pass
Magenta 5.001.75 Pass 2.500.52 Pass
Yellow 5.001.10 Pass 2.500.70 Pass
Black 5.001.06 Pass 2.500.23 Pass
Grey Balance 1.500.50 Pass
Paper Colour 3.000.86 Pass
All Average 3.001.95 Pass
All Maximum 6.005.73 Pass

Pass

C M Y K Reference Lab Measured Lab dH de*ab
100 0 0 0 55.01 -36.96 -50.01 57.02 -36.23 -48.49 0.32 2.62
75 0 0 0 64.71 -26.83 -39.63 66.19 -24.56 -37.56 0.74 3.41
50 0 0 0 75.62 -16.45 -26.76 75.08 -16.48 -27.93 0.58 1.29
25 0 0 0 85.84 -7.45 -14.18 85.73 -7.56 -15.26 0.40 1.09
0 100 0 0 48.00 74.00 -2.96 49.27 72.93 -2.40 0.52 1.75
0 75 0 0 58.34 55.03 -6.39 59.90 52.77 -5.21 0.93 2.99
0 50 0 0 71.25 33.69 -7.31 71.02 34.90 -6.71 0.83 1.37
0 25 0 0 83.80 15.37 -5.79 83.79 16.43 -5.93 0.23 1.07
0 0 100 0 89.02 -4.95 92.93 89.32 -5.69 93.69 0.70 1.10
0 0 75 0 90.04 -4.71 67.95 89.82 -5.23 69.71 0.40 1.85
0 0 50 0 91.56 -4.02 40.95 91.67 -4.92 42.66 0.72 1.94
0 0 25 0 93.31 -2.08 17.56 93.24 -2.02 16.60 0.06 0.97

70 0 100 60 35.37 -25.38 25.68 37.81 -26.18 26.94 0.31 2.86
20 100 0 40 31.04 47.96 -9.06 31.82 48.17 -9.52 0.41 0.93

100 100 0 40 18.31 15.66 -32.74 19.05 18.02 -33.86 1.60 2.71
0 0 0 0 95.03 0.05 -2.14 95.72 0.39 -2.53 0.30 0.86
0 0 0 5 92.00 0.03 -2.09 92.44 0.27 -2.23 0.23 0.53
0 0 0 10 88.95 -0.01 -2.07 89.08 0.16 -2.39 0.16 0.39
0 0 0 30 76.10 -0.11 -2.03 76.16 0.41 -1.98 0.53 0.53
0 0 0 50 61.82 -0.11 -1.59 62.01 0.63 -1.77 0.70 0.78
0 0 0 70 45.55 -0.06 -0.89 47.09 0.23 -1.75 0.25 1.79
0 0 0 85 31.75 -0.01 -0.46 33.63 0.19 -1.50 0.13 2.16
0 0 0 100 16.03 -0.01 -0.01 16.16 1.04 -0.05 0.23 1.06
0 100 100 0 47.02 68.01 47.99 48.63 67.35 49.07 1.26 2.05
0 70 70 0 58.55 47.13 37.80 60.11 44.88 39.45 2.72 3.20
0 40 40 0 74.18 22.97 21.36 73.89 24.69 21.25 1.22 1.74

100 0 100 0 50.04 -64.96 27.02 53.18 -61.39 30.22 4.39 5.73
70 0 70 0 62.17 -39.79 20.97 63.22 -37.65 23.61 3.35 3.55
40 0 40 0 76.97 -19.03 10.98 76.98 -19.45 10.19 0.90 0.90

100 100 0 0 23.91 22.13 -46.08 25.41 24.55 -47.33 1.61 3.11
70 70 0 0 40.93 17.90 -36.62 42.65 19.66 -35.30 2.17 2.79
40 40 0 0 63.70 10.36 -23.79 63.36 11.99 -24.54 1.17 1.83
0 40 70 0 72.64 21.93 47.66 72.23 23.66 50.34 0.44 3.21
0 70 100 60 32.76 24.39 31.99 32.42 22.01 30.87 1.25 2.65

70 100 0 0 30.40 38.73 -34.93 32.33 41.26 -34.36 2.09 3.24
0 70 100 0 57.61 46.86 58.74 59.15 45.68 60.96 2.29 2.95

100 70 0 0 33.10 2.84 -47.27 34.49 4.97 -46.70 2.17 2.61
100 0 40 0 52.36 -52.25 -20.22 54.61 -50.82 -18.70 0.91 3.07
40 0 100 0 73.67 -22.80 67.51 73.79 -21.61 67.33 1.08 1.21
4 3 3 0 92.13 0.21 -2.28 92.27 0.67 -2.32 0.44 0.48
9 6 7 0 88.81 -0.13 -1.97 89.01 -0.46 -2.46 0.26 0.62

27 19 20 0 76.14 -0.29 -2.16 76.15 0.28 -2.16 0.57 0.57
45 35 35 0 62.19 -0.07 -1.81 62.63 0.53 -2.62 0.53 1.10
65 56 57 0 45.83 0.79 0.54 47.13 1.55 -1.23 1.63 2.32
85 77 77 0 32.03 -0.06 -0.50 34.13 -0.52 -1.78 0.16 2.50

100 100 100 0 22.90 0.17 -0.08 24.86 0.57 -1.37 0.37 2.38

Report generated by proofSIGN v1.5 by Bodoni Systems Ltd - www.bodoni.co.uk

Measured Colours
Target Colours

+20-20

+20

-20

+40-40

+40

-40

+60-60

+60

-60

+80-80

+80

-80

0
0

A sample PDF report

The report will automatically open if the preferences are set to do so.



Page 9

Printing a Label
From the View Results window click ‘Print Label’. If this is the first time you have printed a label, and you haven’t yet 
gone into the ‘Page Setup’ then proofSIGN will automatically open the ‘Page Setup Window’

The labels have been optimised for the Dymo Labelwriter 400 ‘Large Address Label 99012’ - 35.7x88.5mm

	
Page Setup on a Mac                                                         Page Setup on a Windows PC

On a Windows PC, from the Page Setup window click ‘Printer’. Select the label printer you are using and click ‘Prop-
erties’. Select Landscape mode, then click on ‘Advanced’. Set the label size as ‘Large Address 99012’ ( or whatever 
you are using ) and click ‘OK’. Keep Clicking OK to return to the Page Setup window as shown above and set all the 
margins to zero. If you are using a different label size than recommended, then you may need to set the margins ap-
propriately.

proofSIGN remembers these settings so that the next time you print a label you don’t need to go into the Page Setup 
window again. If you change label printer or label size, then you can set the page settings from the File menu and 
selecting ‘Page Setup’.

With the page settings set correctly, the print dialog window opens. Make sure the correct printer is selected and click 
‘Print’

ISO Test Job

Epson Stylus Pro 7800

proofSIGN ISO - ISO Coated v2 (ECI)

Bodoni Systems Ltd

Friday, 20 July 2007

!E76(ab) !E(5.00)

Cyan

Magenta 

Yellow 

Black 

2.62

1.75

1.10

1.06

Paper 

Average

Max

!E(3.00)

!E(3.00)

!E(6.00)

Grey !H(1.50) 0.50

0.32

0.52

0.70

0.23

!H(2.50)

0.86

1.95

5.73 Signed

proofSIGN by Bodoni Systems Ltd v1.5.0

Pass

proofSIGN Label

The job name, company name, proofer name and chart definition are included on the label as well as the ∆E toler-
ances and measurements and time of reading.
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Preferences
You can open the Preferences by pressing ‘command ?’ on a mac, or ’control ?’ on a PC. You can also goto the proof-
SIGN menu and select ‘Preferences’ on a Mac, or the File Menu and select Preferences.

Preferences window

Setting Tolerances
You can alter the pass tolerances for your charts by unchecking ‘use tolerances from chart definition’ and entering 
your own tolerances.

Open PDF report after generation
With this option checked the PDF report will auto open after it has been generated.

Show suggestions if verification fails
If you proof fails to be within the set tolerances proofSIGN opens a window to give you siggestions on what you might 
be able to do to rectify the problem. If you don’t want this then uncheck this option.

Adding / Removing Proofers
If you are using more than one proofer to print proofs, you can add another proofer to the list you can select by click 
on the ‘+’ icon next to the select proofer menu.

If you want to remove a proofer from the list, then select the proofer you wish to remove and click the ‘-’ icon.

Adding / Removing Chart Standards
Click on the ‘+’ icon to add a new chart standard. Look at the section titled ‘Adding new Chart Standards’
If you wish to remove a chart definition then click the ‘-’ icon.

Saving Preferences
Clicking ‘OK’ Confirms any changes you have made. Click “Cancel’ to revert the preferences. Any proofers
or Charts you have removed will still be removed.
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Adding new chart standards
proofSIGN comes included with chart standards which will verify your proofs to several ISO standards using the 
FOGRA mediawedge 2.0a , or the supplied proofSIGN chart.

You can use proofSIGN to verify your proof to any ICC CMYK reference profile by adding a new chart standard from 
the Preferences window.

Open the Preferences window and click on the ‘+’ icon next to ‘Chart Standard’ to open up the ‘Add Chart standard’ 
window

Select the chart layout.
Choose ‘ProofSIGN Chart’ if you are using the supplied proofSIGN Chart.tif. You can also select ‘FOGRA Mediawedge 
2.0a’ if that is the chart layout you are using.

Select the Profile
Clicking ‘Select Profile’ and select the CMYK ICC Profile you wish to use.

Once you have chosen a profile the target Lab values are calculated for the CMYK primaries and paper colour.
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Setting Tolerances
If it recommended that you use the default tolerances for verifying your proofs.

If you uncheck the ‘Use default tolerances for chart’ you can change the ∆e tolerances for the primaries ( the CMYK 
solids ), and the maximum, average and paper colour ∆e.

Confirming adding a new chart standard
Once you have selected the CMYK reference profile and have set the desired tolerances click on the ‘Add’ button. The  
chart standard is added to the standards list available.

Clicking on ‘Cancel’ will close the window and no chart standard will be added.


